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Nomenclature for a typical xy plot.  Figure 5.1–1, page 220
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An Example: The following MATLAB session plots y 
=  0.4 √1.8x for 0 ≤  x ≤  52, where y represents 
the height of a rocket after launch, in miles, and x 
is the horizontal (downrange) distance in miles.

>>x = 0:0.1:52;
>>y = 0.4*sqrt(1.8*x);
>>plot(x,y)
>>xlabel(’Distance (miles)’)
>>ylabel(’Height (miles)’)
>>title(’Rocket Height as a Function of 
Downrange Distance’)

5-35-3

The resulting plot is shown on the next slide.



The autoscaling feature in MATLAB selects tick-mark 
spacing. 
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The plot will appear in the Figure window. You can 
obtain a hard copy of the plot in several ways:

1.  Use the menu system. Select Print on the File 
menu in the Figure window. Answer OK when you 
are prompted to continue the printing process.

2.  Type print at the command line. This command 
sends the current plot directly to the printer.

3.  Save the plot to a file to be printed later or 
imported into another application such as a word 
processor. You need to know something about 
graphics file formats to use this file properly. See 
the subsection Exporting Figures (page 225).
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When you have finished with the plot, close the 
figure window by selecting Close from the File 
menu in the figure window.

Note that using the Alt-Tab key combination in 
Windows-based systems will return you to the 
Command window without closing the figure 
window. 

If you do not close the window, it will not reappear 
when a new plot command is executed. 
However, the figure will still be updated.
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Requirements for a Correct Plot 
(Table 5.1-1, page 221)

The following list describes the essential features of any 
plot:

1.  Each axis must be labeled with the name of the 
quantity being plotted and its units! If two or more 
quantities having different units are plotted (such as 
when plotting both speed and distance versus time), 
indicate the units in the axis label if there is room, or in 
the legend or labels for each curve.

2.  Each axis should have regularly spaced tick marks at 
convenient intervals—not too sparse, but not too dense
—with a spacing that is easy to interpret and 
interpolate. For example, use 0.1, 0.2, and so on, 
rather than 0.13, 0.26, and so on.

5-75-7 (continued …)



3.  If you are plotting more than one curve or data set, 
label each on its plot or use a legend to distinguish 
them.

4.  If you are preparing multiple plots of a similar type or 
if the axes’ labels cannot convey enough information, 
use a title.

5.  If you are plotting measured data, plot each data 
point with a symbol such as a circle, square, or cross 
(use the same symbol for every point in the same 
data set). If there are many data points, plot them 
using the dot symbol.
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Requirements for a Correct Plot (continued)

(continued …)



6.  Sometimes data symbols are connected by lines to 
help the viewer visualize the data, especially if there 
are few data points. However, connecting the data 
points, especially with a solid line, might be 
interpreted to imply knowledge of what occurs 
between the data points. Thus you should be careful 
to prevent such misinterpretation.

7.  If you are plotting points generated by evaluating a 
function (as opposed to measured data), do not use 
a symbol to plot the points. Instead, be sure to 
generate many points, and connect the points with 
solid lines.
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Requirements for a Correct Plot (continued)



The grid and axis Commands

The grid command displays gridlines at the tick marks 
corresponding to the tick labels.  Type grid on to add 
gridlines; type grid off to stop plotting gridlines. When 
used by itself, grid toggles this feature on or off, but 
you might want to use grid on and grid off to be 
sure.

You can use the axis command to override the 
MATLAB selections for the axis limits. The basic syntax 
is axis([xmin xmax ymin ymax]). This command 
sets the scaling for the x- and y-axes to the minimum 
and maximum values indicated. Note that, unlike an 
array, this command does not use commas to separate 
the values.

5-105-10 More? See page 222.



Example of a Figure window.  Figure 5.1–2Example of a Figure window.  Figure 5.1–2
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The fplot command is a “smart” plotting function.  Figure 5.1–3a 
 See pages 223-224.
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The function in Figure 5.1–3b generated with the plot 
command, which gives more control than the fplot 
command. 
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Plotting Polynomials with the polyval Function.

To plot the polynomial 3x5 + 2x4 – 100x3 + 2x2 – 7x + 90 
over the range –6 ≤  x ≤  6 with a spacing of 0.01, you 
type

>>x = -6:0.01:6;
>>p = [3,2,-100,2,-7,90];
>>plot(x,polyval(p,x)),xlabel(’x’), ...
   ylabel(’p’)
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Saving Figures

    To save a figure that can be opened in subsequent 
MATLAB sessions, save it in a figure file with the .fig 
file name extension. 

To do this, select Save from the Figure window File 
menu or click the Save button (the disk icon) on the 
toolbar. 

If this is the first time you are saving the file, the Save 
As dialog box appears. Make sure that the type is 
MATLAB Figure (*.fig). Specify the name you want 
assigned to the figure file. Click OK.
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Exporting Figures

To save the figure in a format that can be used by 
another application, such as the standard graphics file 
formats TIFF or EPS, perform these steps.

1.  Select Export Setup from the File menu. This dialog 
lets you specify options for the output file, such as the 
figure size, fonts, line size and style, and output format.

2.  Select Export from the Export Setup dialog. A 
standard Save As dialog appears.

3.  Select the format from the list of formats in the Save 
As type menu. This selects the format of the exported 
file and adds the standard file name extension given to 
files of that type.

4.  Enter the name you want to give the file, less the 
extension.  Then click Save.

5-165-16 More? See pages 225-226.



On Windows systems, you can also copy a figure to 
the clipboard and then paste it into another 
application:

1.  Select Copy Options from the Edit menu. The 
Copying Options page of the Preferences dialog 
box appears.
2.  Complete the fields on the Copying Options 
page and click OK.
3.  Select Copy Figure from the Edit menu.
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Hints for Improving Plots (Table 5.1-3, page 226)

The following actions, while not required, can 
nevertheless improve the appearance of your plots:

1.  Start scales from zero whenever possible.  This 
technique prevents a false impression of the 
magnitudes of any variations shown on the plot.

2.  Use sensible tick-mark spacing.  If the quantities are 
months, choose a spacing of 12 because 1/10 of a 
year is not a convenient division. Space tick marks as 
close as is useful, but no closer.  If the data is given 
monthly over a range of 24 months, 48 tick marks 
might be too dense, and also unnecessary.

5-185-18
(continued …)



3.  Minimize the number of zeros in the data being 
plotted. For example, use a scale in millions of dollars 
when appropriate, instead of a scale in dollars with 
six zeros after every number.

4.  Determine the minimum and maximum data values 
for each axis before plotting the data. Then set the 
axis limits to cover the entire data range plus an 
additional amount to allow convenient tick-mark 
spacing to be selected.

For example, if the data on the x-axis ranges from 1.2 
to 9.6, a good choice for axis limits is 0 to 10. This 
choice allows you to use a tick spacing of 1 or 2.

5-195-19

Hints for Improving Plots (continued)

(continued …)



5.  Use a different line type for each curve when 
several are plotted on a single plot and they cross 
each other; for example, use a solid line, a dashed 
line, and combinations of lines and symbols. Beware 
of using colors to distinguish plots if you are going to 
make black-and-white printouts and photocopies.

6.  Do not put many curves on one plot, particularly if 
they will be close to each other or cross one another 
at several points.

7.  Use the same scale limits and tick spacing on each 
plot if you need to compare information on more 
than one plot.

5-205-20

Hints for Improving Plots (continued)



Subplots

You can use the subplot command to obtain several 
smaller “subplots” in the same figure. The syntax is 
subplot(m,n,p). This command divides the Figure 
window into an array of rectangular panes with m rows 
and n columns. The variable p tells MATLAB to place 
the output of the plot command following the 
subplot command into the pth pane. 

For example, subplot(3,2,5) creates an array of six 
panes, three panes deep and two panes across, and 
directs the next plot to appear in the fifth pane (in the 
bottom-left corner).
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The following script file created Figure 5.2–1, which shows 
the plots of the functions y =  e−1.2x sin(10x +  5) for 0 ≤  x 
≤  5 and y =  | x3 − 100|  for −6 ≤  x ≤  6.

x = 0:0.01:5;
y = exp(-1.2*x).*sin(10*x+5);
subplot(1,2,1)
plot(x,y),axis([0 5 -1 1])
x = -6:0.01:6;
y = abs(x.^3-100);
subplot(1,2,2)
plot(x,y),axis([-6 6 0 350])

5-225-22

The figure is shown 
on the next slide.



Application of the subplot command.  Figure 5.2–1
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Data Markers and Line Types

To plot y versus x with a solid line and u versus v with 
a dashed line, type plot(x,y,u,v,’--’), where the 
symbols ’--’ represent a dashed line. 

Table 5.2–1 gives the symbols for other line types. 

To plot y versus x with asterisks (*) connected with a 
dotted line, you must plot the data twice by typing 
plot(x,y,’*’,x,y,’:’).
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To plot y versus x with green asterisks (∗) connected 
with a red dashed line, you must plot the data twice by 
typing plot(x,y,’g*’,x,y,’r--’).
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Specifiers for data markers, line types, and colors.
Table 5.2–1, page 228.

Data markers†

Dot (.)
Asterisk (*)
Cross (× )

Circle ()
Plus sign (+ )
Square (  )
Diamond (  )
Five-pointed star (w)

.
*
×

+
s
d
p

Line types

Solid line
Dashed line
Dash-dotted line
Dotted line

––
– –
– .
….

Colors

Black
Blue
Cyan
Green
Magenta
Red
White
Yellow

k
b
c
g
m
r
w
y

†Other data markers are available. Search for “markers” in MATLAB help.
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Use of data markers.  Figure 5.2–2, page 229.

5-275-27

More? 
See 
pages 
273-274.



Labeling Curves and Data 

The legend command automatically obtains from 
the plot the line type used for each data set and 
displays a sample of this line type in the legend 
box next to the string you selected. The following 
script file produced the plot in Figure 5.2–3 (see 
next slide).

x = 0:0.01:2;
y = sinh(x);
z = tanh(x);
plot(x,y,x,z,’--’),xlabel(’x’), ...
ylabel(’Hyperbolic Sine and 
Tangent’), ...
legend(’sinh(x)’,’tanh(x)’)
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Application of the legend command.  Figure 5.2–3, page 230
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Application of the hold command.  Figure 5.2–4, page 231
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Why use log scales?  Rectilinear scales cannot properly 
display variations over wide ranges.  Figure 5.2-5a, page 
233.
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A log-log plot can display wide variations in data values.
Figure 5.2-5b, page 233.

5-325-32

See 
pages 
233-
234.



Logarithmic Plots

It is important to remember the following points when 
using log scales:

1.  You cannot plot negative numbers on a log scale, 
because the logarithm of a negative number is not 
defined as a real number.

2.  You cannot plot the number 0 on a log scale, 
because log10 0 =  ln 0 =  −∞. You must choose an 
appropriately small number as the lower limit on the 
plot.

5-335-33
(continued…)



3.  The tick-mark labels on a log scale are the actual 
values being plotted; they are not the logarithms of 
the numbers. For example, the range of x values in 
the plot in Figure 5.3–2 is from 10−1 =  0.1 to 102 
=  100.

4.  Gridlines and tick marks within a decade are 
unevenly spaced. If 8 gridlines or tick marks occur 
within the decade, they correspond to values equal 
to 2, 3, 4, . . . , 8, 9 times the value represented by 
the first gridline or tick mark of the decade.

5-345-34

Logarithmic Plots (continued)

(continued…)



5. Equal distances on a log scale correspond to 
multiplication by the same constant (as opposed to 
addition of the same constant on a rectilinear 
scale). 

For example, all numbers that differ by a factor of 10 
are separated by the same distance on a log 
scale. That is, the distance between 0.3 and 3 is 
the same as the distance between 30 and 300. 
This separation is referred to as a decade or cycle. 

The plot shown in Figure 5.3–2 covers three decades 
in x (from 0.1 to 100) and four decades in y and is 
thus called a four-by-three-cycle plot.

5-355-35

Logarithmic Plots (continued)



     MATLAB has three commands for generating 
plots having log scales. The appropriate 
command depends on which axis must have a 
log scale. 

1. Use the loglog(x,y) command to have both 
scales logarithmic.

2.  Use the semilogx(x,y) command to have the 
x scale logarithmic and the y scale rectilinear.

3.  Use the semilogy(x,y) command to have the 
y scale logarithmic and the x scale rectilinear.
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Command

bar(x,y)

plotyy(x1,y1,x2,y2)

polar(theta,r,’type’)

stairs(x,y)

stem(x,y)

Description

Creates a bar chart of y versus x.

Produces a plot with two y-axes, y1 
on the left and y2 on the right.

Produces a polar plot from the polar 
coordinates theta and r, using the 
line type, data marker, and colors 
specified in the string type.

Produces a stairs plot of y versus x.

Produces a stem plot of y versus x.

Specialized plot commands.  Table 5.2-3, page 236
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Exponential and Power Functions Plotted on Exponential and Power Functions Plotted on 
Log Scales (Figure 5.2-6, page 235)Log Scales (Figure 5.2-6, page 235)

5-38 The program is on pages 234-235.



A polar plot showing an orbit having an eccentricity of 0.5.
Figure 5.2–7, page 237.

5-395-39

See pages 
236-237.



Error Plots, Figure 5.2-8, page 238.Error Plots, Figure 5.2-8, page 238.

5-40 The code is on page 238.



Publishing Reports Containing GraphicsPublishing Reports Containing Graphics
See Pages 238-240.See Pages 238-240.
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Interactive Plotting in MATLAB

This interface can be advantageous in situations where:

•   You need to create a large number of different types of 
plots,

•   You must construct plots involving many data sets,
•   You want to add annotations such as rectangles and 

ellipses, or
•   You want to change plot characteristics such as tick 

spacing, fonts, bolding, italics, and colors.

5-425-42
For details, see pages 241-246.



The interactive plotting environment in MATLAB is a set of 
tools for:

•   Creating different types of graphs,
•   Selecting variables to plot directly from the Workspace 

Browser,
•   Creating and editing subplots,
•   Adding annotations such as lines, arrows, text, 

rectangles, and ellipses, and
•   Editing properties of graphics objects, such as their 

color, line weight, and font.
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The Figure toolbar displayed.  Figure 5.3–1, page 241.
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The Figure and Plot Edit toolbars displayed.  Figure 5.3–2, 
page 243.
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    The Plot Tools interface includes the following three 
panels associated with a given figure.

•   The Figure Palette:  Use this to create and arrange 
subplots, to view and plot workspace variables, and to 
add annotations.

•   The Plot Browser:  Use this to select and control 
the visibility of the axes or graphics objects plotted in 
the figure, and to add data for plotting.

•   The Property Editor:  Use this to set basic 
properties of the selected object and to obtain access 
to all properties through the Property Inspector.

5-465-46



The Figure window with the Plot Tools The Figure window with the Plot Tools 
activated. Figure 5.3-3, page 244.activated. Figure 5.3-3, page 244.
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Three-Dimensional Line Plots:

The following program uses the plot3 function to 
generate the spiral curve shown in Figure 5.4–1, page 
247.

>>t = 0:pi/50:10*pi;
>>plot3(exp(-0.05*t).*sin(t),...
  exp(-0.05*t).*cos(t),t),...
  xlabel(’x’),ylabel(’y’),zlabel(’z’),grid

5-485-48

See the next slide.



The curve x =  e−0.05t sin t, y =  e−0.05t cos t, z =  t plotted with 
the plot3 function.  Figure 5.4–1, page 247.
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Surface Plots:   

The following session shows how to generate the 
surface plot of the function z =  xe−[(x−y2)2+ y2], for −2 ≤  x 
≤  2 and −2 ≤  y ≤  2, with a spacing of 0.1. This plot 
appears in Figure 5.4–2, page 248.

>>[X,Y] = meshgrid(-2:0.1:2);
>>Z = X.*exp(-((X-Y.^2).^2+Y.^2));
>>mesh(X,Y,Z),xlabel(’x’),ylabel(’y’),...
   zlabel(’z’)

5-505-50

See the next slide.



A plot of the surface z =  xe−[(x−y2)2+ y2] created with the mesh 
function.  Figure 5.8–2
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The following session generates the contour plot of the 
function whose surface plot is shown in Figure 5.8–2; 
namely, z =  xe−[(x−y2)2+ y2], for −2 ≤  x ≤  2 and −2 ≤  y ≤  2, 
with a spacing of 0.1. This plot appears in Figure 5.4–3, 
page 249.

>>[X,Y] = meshgrid(-2:0.1:2);
>>Z = X.*exp(-((X- Y.^2).^2+Y.^2));
>>contour(X,Y,Z),xlabel(’x’),ylabel(’y’)

5-525-52

See the next slide.



A contour plot of the surface z =  xe−[(x−y2)2+ y2] created with the 
contour function.  Figure 5.4–3
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Function
contour(x,y,z)

mesh(x,y,z)

meshc(x,y,z)

meshz(x,y,z)

surf(x,y,z)

surfc(x,y,z)

[X,Y] = meshgrid(x,y)

[X,Y] = meshgrid(x)

waterfall(x,y,z)

Description
Creates a contour plot.

Creates a 3D mesh surface plot.

Same as mesh but draws contours under the 
surface.

Same as mesh but draws vertical reference lines 
under the surface.

Creates a shaded 3D mesh surface plot.

Same as surf but draws contours under the 
surface.

Creates the matrices X and Y from the vectors x 
and y to define a rectangular grid.

Same as [X,Y]= meshgrid(x,x).

Same as mesh but draws mesh lines in one 
direction only.

Three-dimensional plotting functions.  Table 5.4–1, page 250.

5-545-54



Plots of the surface z =  xe−(x2+ y2) created with the mesh 
function and its variant forms: meshc, meshz, and 
waterfall. a) mesh, b) meshc, c) meshz, d) waterfall.
Figure 5.4–4, page 250.
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The following slides contain the figures from The following slides contain the figures from 
the homework problems.the homework problems.
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Graphical solution of equations: Circuit representation of a 
power supply and a load.  Figure P25, page 257.
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Figure P26 on page 257.
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Figure P35 on page 260.

5-595-59
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